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1. Ievads  

Paldies, ka izvēlējā�es ProtaStructure komplekta ProtaSteel - tērauda detaļu un savienojumu izveides moduli.    

 Galvenais tērauda modelis ir jāizveido ProtaStructure. Modeli ir vienkārši eksportēt un atvērt ProtaSteel.

Programmā ProtaSteel jūs varēsiet:  

•  Modelēt tērauda elementus, piemēram, jumta kopturi, latas, kāpnes u�.  

•  Pielāgot elementus galīgajām pozīcijām, lai iegūtu precīzu informāciju. 

•  Izveidot un noformēt tērauda savienojumus. 

•  Jebkurus tērauda savienojumus izveidot manuāli, saglabāt tos bibliotēkā un atkārto�   

 

•  Izgatavot tērauda konstrukcijas un savienojumu inženierrasējumus.  

•  Kopīgot 3D modeli ar citu BIM pla�ormu, piemēram, Tekla Structures.  

 

 

 

 

 

 

 

 

 

 

Pirms turpināt, ļo� ieteicams iepazī�es ar lietošanas instrukciju ProtaStructure, jo ir nepieciešamas  

pamata zināšanas par ProtaStructure.  

Šīs rokasgrāmatas mērķis ir ātri sākt darbu.  

Jums vajadzētu iemācī�es ProtaSteel pamatus aptuveni 2 stundu laikā.  

2. Eksportēt modeli uz ProtaSteel  

Tērauda parauga modelis jau ir izveidots un instalēts noklusējuma instalācijas mapē ProtaStructure.

Tagad mēs atvērsim modeli, veiksim analīzi un eksportēsim uz ProtaSteel.  

➢ Atveriet ProtaStructure un parādīsies dialoglodziņš Open Project   

➢ Atlasīt un atvērt projektu Quick_Start Steel_Complete 

➢ Ejiet uz Analysis → Building Analysis 

➢ Ejiet uz Analysis tab →  atķeksējiet Building Analysis → Start  

➢ Aizveriet izvēlni Building Analysis 

➢ Ejiet uzSteel Design  →  Load  ProtaSteel  

ProtaSteel sāks darbo�es un ielādēs projekta modeli. 

ProtaSteel modelis �ek izveidots apakšmapē “ProtaSteel” projekta mapē. 

 

 izmantot līdzīgos mezglos.
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3. Lietotāja interfeiss 

Dažādas ProtaSteel lietotāja saskarnes sastāvdaļas ir redzamas zemāk.  

 

 

 

  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Noklusējuma ska� �ek izveido� mapē Views. Pēc noklusējuma izveido�e ska� ir katra stāva 3D skats un plāna skats. 
Veiciet dubultklikšķi uz vajadzīgā skata, lai tam piekļūtu.   

Grafiskais redaktors atbalsta vairākus logus; jūs varat atvērt �k daudz logu, cik vēla�es.

Modelēšanu var veikt gan plāna, gan 3D skatā.  

Rāmja izveides rīks     

Pakalpojumā ProtaSteel var izveidot �kai sijas, latojumu, saites, kāpņu elementus, karnīzes utml.  

Galvenie elemen�, piemēram, sija, kolonna un s�prinājumi, jāizveido ProtaStructure.  

Manuālās detalizēšanas rīks   

Tie ir sekundārie detalizēšanas rīki, piemēram, me�nāšanas, profila plāksnes izveidošana, elementu griešana    

un apgriešana, un profila pielāgošana. 

Savienojumu Macros   

Tie ir visi savienojumu izveides rīki.  

 

  

Padoms:  Ja virzīsiet peles kursoru virs jebkuras ikonas, �ks parādīts rīka padoms ar detalizētu  

 

  

 

Failu rīki  

Project 

Explore

r 

Modeļa skats 

Rāmja rīki  Manuāla detalizēšana  Savienojuma Macros  Sekundārais Macros  

Redzamības filtri  

Atlasāmības filtri  

U�li�es 

Skata režīms 

Skata izveide  

Punktu rīki 

Kopēt, spoguļot 
& rotēt  

Atsauces objekts  

Ska�jumu rīks 

Bar 
Apakšējā statusa josla  Darba vienības 

paskaidrojumu, kā to izmantot. Ar peles labo pogu noklikšķinot uz macro ikonas, varat iesta�t 
noklusējuma parametrus, kas �ks izmanto� katru reizi, kad tā �ek palaista.
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4. Zoom & Pan Metodes 

Skata manipulācijas ir līdzīgas kā ProtaStructure. Jums būs visvieglāk izmantot peles ritenī�, lai:  

Pietuvināt  – ri�niet peles riteni uz augšu  

A�ālināt   – ri�niet peles riteni uz leju   

Pārvietot   – turiet nospiestu peles riteni un velciet   

Rotēt    –  ar peles labo pogu noklikšķiniet un velciet 

Ir noderīgi šādi īsinājumtaus�ņi:  

Pietuvināt visu   – Home     → Tuviniet, lai viss saturs būtu redzams skata logā  

Origin of Interest  – F9 taus�ņš           → Atlasiet interesējošo izcelsmi, noklikšķinot uz jebkura mezgla vai 

objekta (piemēram, skrūves). Pēc tam modelis pagriezīsies ap izvēlēto punktu.

 

5. Atlases metodes  

➢ Ar peles kreiso taus�ņu noklikšķiniet uz vienības, lai to atlasītu.  

➢ Lai atlasītu vairākas vienības, turiet nospiestu CTRL taus�ņu, kamēr tās izvēla�es.  

Jūs varat vilkt ar peli, lai piekļūtu citām atlases opcijām:  

➢ Velciet no kreisās uz labo, lai izveidotu taisnstūra lodziņu. 
Atlaižot peles pogu, �ks atlasītas visas vienības, kas pilnībā atrodas lodziņā.  

➢ Līdzīgi velciet no labās uz kreiso pusi, un �ks atlasītas visas vienības, kas atrodas lodziņā vai to šķērso. 
   

➢ Lai atceltu vienību atlasi, noklikšķiniet ar peles kreiso taus�ņu uz jebkuras tukšas vietas jebkurā skatā.     

6. Ska� un skata iesta�jumi 

Pēc noklusējuma 3D skata vispārējais elements �ek izveidots un parādīts, atverot projektu.  

 

Ska� �ek parādī� mapes Views kreisajā Explorer rū�.   

➢ Veiciet dubultklikšķi uz vajadzīgā skata kreisajā Explorer logā, lai to atvērtu.  

Jūs varat atvērt �k daudz skatu, cik vēla�es. 

 

 
 

➢ Veicot dubultklikšķi uz Views, �ks atvērts skatu pārvaldnieks, kur varēsit ātri:  

 

•  Atvērt skatu  

•  Aizvērt skatu 

•  Dzēst skatu  

•  Parādīt skata īpašības  

 

Tiek izveidots arī katra stāva plāns.
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Ja jums ir atvēr� vairāki ska�, varat tos pārvaldīt, piemēram, ievietot ekrānā, dodo�es uz 

Windows →  Tile Horizontal / Tile Ver�cal / Cascade . 

Jūs varat izmainīt Object Draw Mode ejot uz Views → Object Draw Modes   

Īsinājumtaus�ņa ikona ir atrodama arī ver�kālās labās-

 puses rīkjoslās   

➢ Nepārtrauk� nospiežot taus�ņu kombināciju Alt + D,  

 

7. Jaunu skatu veidošana 

Jaunus skatus var izveidot, dodo�es uz Views → Create View 

 

Izveidosim jaunu šķērsgriezuma skatu pa režģi 3: 

➢ Ejiet uz Views → Create Views → By Two Points  

➢ Noklikšķiniet uz diviem punk�em, lai definētu plakni → skats �ks izveidots, kā parādīts zemāk      

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2 

1 

Piezīme. Šķērsgriezuma skats �ek veidots no tā paša 3D modeļa, bet �ek ska�ts no cita kameras leņķa.
Ak�vajā skatā veiktās izmaiņas �ek automā�ski atspoguļotas visos pārējos skatos.

Parādāmo apjomu, robežu un objektus var iesta�t, izmantojot .View Proper�es. 

Padoms: Kad peles kursors kursēs uz 

 

 

�ek parādī� rasēšanas režīmi.

2. punktu, parādīsies balta bul�ņa.

Šī baltā līnija norāda ska�šanās virzienu. 

Šajā gadījumā iepriekšminētais skats ir

ēkas ska�jums.
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Lai piekļūtu View Proper�es:  

➢ Veiciet dubultklikšķi jebkurā jaunā skata vietā → parādīsies View Proper�es    

 
➢ Piešķiriet skatam jaunu nosaukumu Axis 3 

➢ Mainiet augšup (Up) (+) un lejup (down) a�ecīgi uz 1000mm un -1000mm     

Tas nozīmē, ka skatā �ks rādī� �kai elemen� 1 m a�ālumā no plaknes un ārpus tās. 

Tas padarīs skatu mazāk pārblīvētu, jo elemen� gar ci�em režģiem �ks paslēp�. 

Ja �ek ievadītas nulles vēr�bas, tas būs neierobežots.  

•  Up-down metode:-   

- Par�al: �ks parādīts jebkurš elements, kas daļēji pastāv noteiktajā apjomā.  
- Full: Tiks parādī� �kai �e elemen�, kas pilnībā pastāv noteiktā apjomā.  

➢ Noklikšķiniet uz OK, lai aizvērtu dialoglodziņu, un skats �ks atjaunināts.  

Jebkurš šķērsgriezuma skats pēc savas bū�bas ir 3D skats, tāpēc jūs joprojām varat pagriezt skatu. 

➢ Ar peles labo pogu noklikšķiniet un velciet, lai pagrieztu Axis 3 skatu.   

Ievērojiet, ka �ek parādī� �kai �e elemen�, kas atrodas 1 m a�ālumā.  

➢ Ejiet uz View Proper�es  

➢ Mainiet Up Down method  sadaļā View proper�es FULL → Apply 

Ievērojiet, ka visas sijas, kas atrodas ārpus 3. ass plaknes, būs paslēptas..  

➢ Nospiediet F4, lai atjaunotu meklēšanu (t.i., atjaunotu sākotnējo ska�šanās virzienu).    

 

 

 

8. Redzamība un atlasāmība 

Varat kontrolēt, kādi objek� ir redzami un atlasāmi, novērtējot dialoglodziņu Drawing Se�ngs dialog:  

➢ Izvēlie�es Drawing Se�ngs View Proper�es lodziņā   

 

Svarīgi: jums jānorāda skatam jauns nosaukums un jāatzīmē “Save”.  

Rasējumu ģenerēšanai rasēšanas modulī var izmantot �kai saglabātos skatus. 

ProtaSteel darba uzsākšanas rokasgrāmata 
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9. Macros  

Lielāko daļu ProtaSteel ikonu, sauc par “macro”.

Macros paras� �ek definēts kā rīks, kas norāda, kā noteikta ievades secība radīs vēlamo izvadi atbilstoši procedūrai.

 Norādījumi par katra makros lietošanu �ek parādī� rīka padomā, ja peles kursoru novietojat virs ikonas.

  
•  Pirms elementa izveidošanas, izmantojot makro, varat iesta�t makro iesta�jumus,   

ar peles labo pogu noklikšķinot uz Macros ikonas, kas atvērs Macros dialoglodziņu.  

•  Kad noklikšķināts uz macros, peles kursors mainīsies uz rokas       ikonu.  

Veiciet nepieciešamās darbības, lai iegūtu vēlamo rezultātu, kā norādīts rīka padomā.   

    •  Makro paliks ak�vizēts; jūs varat turpināt izmantot makro bez atkārtotas klikšķināšanas uz makro ikonas. 

•  Kad esat pabeidzis, nospiediet ESC, lai atceltu un apturētu makro.  

Peles kursors atkal mainīsies uz noklusējuma bul�ņu (atlases režīms).    

•  Pēc elementu izveidošanas grupā, piemēram, latojuma, katram elementam būs savas individuālās īpašības; 

ko var mainīt, veicot dubultklikšķi uz tā → tas parādīs dialoglodziņu Element.     

•  Tomēr visi elemen� joprojām ir sais�� ar macros un tos var mainīt grupā.  

To var izdarīt, atlasot makro zīmi       un pēc tam nospiežot taus�ņu ENTER, �ks atvērts makro dialoglodziņš.   

Pēc izmaiņu veikšanas noklikšķinot uz Apply, �ks piemēro� visi ar makro sais��e elemen�.   

Noklikšķinot uz Get, šis makro �ks iesta�ts kā noklusējums šim un nākamajiem projek�em.   

•  Ja jums ir problēmas ar makro zīmes izvēli, varat atlasīt jebkuru makro elementu vai komponentu  

  

  

•  Visus ar makro sais�tos elementus var atlasīt ar makro zīmi vai makro elementu → nospiediet “CTRL + M”.

  •  Varat arī izdzēst visus makro elementus un komponentus, atlasot makro zīmi un pēc tam nospiežot DELETE.    

•  Pirms makro izpildīšanas ir ļo� ieteicams pārska�t makro iesta�jumus.  

➢ Alterna�vely, click on the 
Visibility/Selectability icon “…”           
in the middle toolbar   

➢ Turn off the Grids & Points  

➢ Apply & see effect 

➢ Go back & turn them back on  

You can Save these different se�ngs as 
different name to quickly re-use them. 

The shortcuts to visibility / selectability 
objects are in the middle toolbar. 
 

(piemēram, savienojuma plāksni), pēc tam nospiediet “M” → tas atlasīs makro →, kam sekos ENTER,
kas parādīs makro dialoglodziņu.

ProtaSteel darba uzsākšanas rokasgrāmata 
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10. Ievietojiet Sag rods  

Programmā ProtaStructure galvenie tērauda elemen� �ek modelē� un izstrādā�.    

Pēc tam, kad modelis ir pārvietots uz ProtaSteel, iespējams, vēlēsie�es pievienot papildu tērauda elementus. 

  

Mēs ievietosim dažus tērauda s�eņus starp latojumu gar 3. asi:  

➢ Veiciet dubultklikšķi uz 3D View Explorer rū�, lai pārietu uz noklusējuma 3D skatu   

➢ Ar peles labo pogu noklikšķiniet uz ikonas Sag Rod          → Tas parādīs Sag Rod Makro dialogu     

➢ Ievadiet nobīdes 50 mm un intervālu skaits = 3 (kā parādīts zemāk)      

ProtaSteel darba uzsākšanas rokasgrāmata 
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➢  Atzīmējiet diagonāli, lai tā ne�ktu iekļauta.  

➢ Izvēlie�es sadaļas profilu, noklikšķinot uz “…” (kā parādīts iepriekš) → Izvēlie�es apaļo joslu D10 → Select.     

➢ Izvēlie�es Get lai šos datus padarītu par 
noklusējuma no šī brīža → OK    

 
Katram sag rod ir savas individuālās īpašības, un to var izvēlē�es, izdzēst vai mainīt.  

➢ Veicot dubultklikšķi uz tā, �ks atklātas tā īpašības.  

Visus sag rod a�ēlo makro zīme.        Tos var mainīt grupā, atlasot šo makro zīmi → nospiediet “Enter”. 
  

➢ Ar peles kreiso taus�ņu noklikšķiniet uz ikonas Sag Rod   

Ievērojiet, ka kursors parvēršas ikonu  tas nozīmē, ka
tas gaida nepieciešamo (-ās) elementa atlases darbību (-as). 

➢ 1 – Noklikšķiniet ar peles kreiso taus�ņu uz apakšējā latojuma. 

➢ 2 –  Noklikšķiniet ar peles kreiso taus�ņu uz augšējā latojuma. 

➢ Ar peles labo pogu noklikšķiniet → Sag Rods �ks ievieto�.   

➢ Ievietojiet cita paneļa sagriezes s�eņus starp režģiem B, C un D, 
izmantojot tās pašas darbības, kas norādītas iepriekš, t.i., sāciet
izvēlē�es zemāko latojumu (nav nepieciešams atkārto� izvēlē�es

 

➢ Nospiediet ESC, lai atceltu makro darbību Sag Rod.
 

Ievērojiet, ka kursors atkal mainās uz noklusējuma bul�ņu  

 

 

1 

2 

Macro Sign 

sag rod ikonu)
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Jūs varat izmantot Sag Rod Connec�on vai Sag Rod Holes makro, lai izveidotu savienojumus ar sagriežamajiem    

 

11. Biedru pielāgošana, izveidojot punktus  

Programmā ProtaSteel, iespējams, vēlēsi�es arī pielāgot to dalībnieku pozīciju, kuri nav precīzi pareizajā pozīcijā, 

  

Programmā ProtaStructure visas ievietotās saites savienosies siju augšdaļā, nevis sijas vidusdaļā (centrālā daļa). 

 

➢ Veiciet dubultklikšķi uz iepriekš izveidotā 3. ass skata Explorer logā.  

➢ Tuviniet diagonālo saišu atrašanās vietu starp režģa C un D.  

 

 

1 

2 

New Point 

➢ Nospiediet Alt + D, līdz redzat �kai  
 

➢ Labās puses rīkjoslā noklikšķiniet uz ikonas  
“Create Dividing Points” 

➢ 1 – Noklikšķiniet uz stara augšējā punkta. 

➢ 2 - Noklikšķiniet uz stara apakšējā punkta. 

Tiek izveidots jauns punkts “+”, .
 

➢ Nospiediet ESC, lai apturētu funkciju. 
 

Diagonālie s�prinājumi ir savieno� ar sijas augšdaļu.

Tā ir precīzāk, ja s�prinājumi savienojas sijas vidū.
 

Lai to izdarītu, sijas vidū jāizveido punkts (vai mezgls).   

 

Ar izveidoto punktu var pārvietot s�prinājuma galus

 

Alt + D, �ek parādī� rasēšanas režīmi. :  

 

s�eņiem un latām.

t.i., galīgo dalībnieku pozīciju precizēšana detalizācijas nolūkos.

uz šo punktu.

PADOMS: pieturot nospiestu taus�ņu kombināciju

dalībnieku kontūru (wireframe mode).

kā parādīts kreisajā a�ēlā.
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12. Biedru orientācijas un koordinātu pielāgošana  

Visu dalībnieku pozīciju un orientāciju var mainīt arī, neradot jaunus punktus.

Mēs veiksim šādus nelielus pielāgojumus dažām grīdas s�prinājumiem: 

➢ Veiciet dubultklikšķi uz 1. stāva skata, lai atvērtu šo skatu.   

➢ Ar peles labo pogu noklikšķiniet un velciet, lai pagrieztu to 3D skatā.  

➢ Tuviniet savienojumu GL 2 / B-C, kur savienojas galbenā sija un 2 horizontālais “L” s�prinājums.     

➢ Nospiediet F9 un noklikšķiniet uz savienojuma, lai to iesta�tu kā punktu, lai rotācija būtu aptuveni šajā punktā.    

 

2 

3 

1 

Before 

A�er 

➢ Augšējā izvēlnes rīkjoslā noklikšķiniet uz 
Adjust Profile Manually

  
   

➢ 1 – Atlasiet diagonālo augšējo s�prinājumu   

➢ 2 - Noklikšķiniet uz esošā galapunkta 

➢ 3 - Noklikšķiniet uz jaunā punkta 

S�prinājuma gals �ks pārvietots uz jauno punktu.

 

 

➢ Atkārtojiet iepriekš minēto 1. līdz 3. darbību  
 

Diagonālo s�prinajumu galīgās pozīcijas ir
 

➢ Veiciet dubultklikšķi uz PS View 1 Explorer rū�,  
lai pārietu uz 3D skatu.  

➢ Tuviniet tajā pašā vietā un pārbaudiet  
diagonālo bikšturu galīgo stāvokli, lai 
pārliecinātos, ka �e ir pareizi. 

 

otram diagonālajam s�prinājumam.

norādītas kreisajā a�ēlā.
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L s�prinajumu orientācija nav simetriska ar otru.  

Mēs pagriezīsim s�prinājumu tā, lai s�prinājuma atloks būtu izlīdzināts ar sijas atloku. 

 

Joprojām pastāv problēma ver�kālā balsta stāvoklī, jo tā ir pārāk tuvu siju augšdaļai.  

Paras� s�prinajumi ir savieno� ar sijas vidusdaļu, tāpēc spēka pārnešana no�ek uz dalībnieku centrālo daļu. 

Nelielu ver�kālās izlīdzināšanas nobīdi var izdarīt, nospiežot. 

➢ Atlasiet s�prinājumu  

➢ Nospiediet Ctrl + Q, lai to pagrieztu, līdz �ek  
sasniegta pareizā orientācija kā kreisajā a�ēlā.  

➢ Atkārtojiet ar pārejiem s�prinājumiem. 

S�prinājumi nāk pārāk tuvu sekundārajamstaru kūlis

Mēs to varam nedaudz novirzīt.  

➢ Nospiediet Ctrl + W, lai horizontāli nobīdītu lenci,  
līdz tā atrodas vistālāk no sekundārā stara. 

➢ Atkārtojiet ar pārejiem s�prinājumiem. 

➢ Veiciet dubultklikšķi uz labā L s�prinājuma.  

Profila rekvizītu dialoglodziņš ļauj mainīt:  

•  Profila / sadaļas �ps, izvēlo�es “…”  

•  Izlīdzināšana (ārpus plaknes, plaknē, rotācija) 

•  Kompensācijas sākums un beigas 

•  Zīmēt rāmja koordinātu sistēmu 

➢ Izmainiet lodziņu no Coordinate System uz
For Analysis & design

 
→

 

Apply 

Rāmja galā parādās 3 bul�ņas, kurās redzama vietējā ass.

 
Ja asis nav redzamas, lūdzu, nospiediet taus�ņu kombināciju 

  

➢ Ievadiet z Start & End Offset uz 100 mm → Apply 

➢ Pārbaudiet 3D skatu - vai s�prinājumi ir pārvieto� uz leju 

➢ Atkārtojiet ar ci�em s�prinājumiem (-100mm) → OK, lai izietu    

 

Shi� away 

Ctrl + E 

away 

Ctrl + W 

away 
Ctrl + R 

away 

F9 & click here 

Shi� away 

Sarkana bulta = x ass; Zaļā bulta ir y ass; Zilā bul�ņa ir z ass.

ALT + D, lai pārslēgtos uz s�epļu rāmi.
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Ctrl + W. Tomēr, izmēģinot šo, jūs atradīsit, ka nobīdes ir pārāk mazas.

Papildu detaļu pielāgošanu var veikt, atklājot profila īpašības.  

Saglabājiet konstruk�vas izmaiņas modeļa reimportēšanas laikā. 

Cilnē General Defini�ons pēc noklusējuma �ek pārbaudīta opcija 

«Preserve construc�ve changes during model re-import». 

 

 

13. Tērauda savienojumi 

Pēc tam, kad esam izveidojuši tērauda elementu pozīciju, mēs varam sākt tērauda elementu "savienošanu",   

t.i., izveidot savienojumus. Savienojumus var izveidot divos veidos:  

1. Automā�ski izmantojot savienojuma makro. 

2. Manuāli, izmantojot komandas Plates, Bolts, Welds & Cuts.   

Macros automā�ski izveidos atbilstošo savienojumu.

Ja no ProtaStructure �ek pārsū�� iekšējie spēki, �e �ks automā�ski ņem� vērā savienojuma projektā.  

Detalizēta projekta pārbaude �ek veikta saskaņā ar EuroCode 3, AISC (LRFD), AISC (ASD), BS5950:  

   •  Sijas un sijas savienojumi: gala plāksne, s�ngrāka gala plāksne, fin plāksne. 

•  Sijas un kolonnas savienojumi: gala plāksne, s�ngrāka gala plāksne, fin plāksne.:   

•  No sijas līdz sijai gala plāksnes savienojums. 

•  Haunch savienojums. 

•  Tiešais me�nāšanas savienojums. 

•  Vienkāršs pamatplāksnes savienojums. 

•  Atloku plāksnes momenta savienojums. 

•  Paplašināts gala plāksnes savienojums. 

•  Bultskrūvju starpsienu savienojums. 

•  Stūra bultskrūvju starpsienu savienojums. 

Tas saglabās dalībnieku kompensācijas korekcijas (piemēram,

dalībnieka pozīciju un izvietojumu), kas veiktas ProtaSteel,

veicot atkārtotu atkārtotu importēšanu no ProtaStructure.

Nākamās importēšanas laikā �ks parādīts brīdinājums: 

Imported Frame's ID in *.cdf file[xxx]: Frame is locked. Therefore, 

in plane, out of plane and start/end offsets were not applied.  

Neņemiet vērā iepriekš minēto brīdinājumu, ja vēla�es,

lai dalībnieku kompensācijas �ktu saglabātas ProtaSteel. 

Ja šī opcija nav atzīmēta (atspējota), ProtaSteel veik�e

ieskai�jumi �ks izmes� nākamās importēšanas laikā no

ProtaStructure.  
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•  Me�nāts starpsienu savienojums. 

•  Stūra me�nāto savienotājelementu savienojums. 

•  Kopņu sēdekļu savienojums. 

A�ecībā uz iepriekš minētajiem savienojumiem var izveidot detalizētu projekta ziņojumu, kas ietver 

gan ģeometriskās pārbaudes, gan jaudas pārbaudes. Turklāt ērtai pārbaudei �ek parādī�

starpposma aprēķini, atsauces uz a�ecīgajiem projekta koda punk�em un atbilstošais vienādojums. 

Standarta savienojumiem �ek veiktas pamata materiālās jaudas pārbaudes:      

•  Visas pieskrūvētās un me�nātās vītņu plāksnes. 

•  Latojums  

•  Savienojumi  

•  Flange Plate Moment savienojumi 

Iepriekš minētajiem savienojumiem �ek veiktas šādas materiāla s�prības pārbaudes:  

•  Plākšņu gultņu pārbaude  

•  Skrūves bīdes un skrūves spriegojuma pārbaude 

•  Me�nāšanas stresa pārbaude 

•  Plāksnes spriegojuma un plākšņu lieces pārbaude   

Iepriekš minētās ir pamata pārbaudes, nevis klauzulas ar klauzulu koda īpašām pārbaudēm.  

Rasējuma ziņojumu nevar sagatavot. Ja nepieciešams, ieteicams veikt savas papildu aprēķinu pārbaudes.   

Automā�skajos savienojumos izmantoto spēku iegūst no augstākās no divām vēr�bām:  

1. No ProtaStructure importēto savienoto dalībnieku kri�skie projektēšanas spēki.  

2. Lietotāja definēts Capacity Ra�o sadaļā Profile Proper�es> Detalizētas definīcijas.   

Capacity Ra�o = Design Force  / Maximum Member Capacity (vienāds ar mazāk nekā 1). 

Tas ir paredzēts, lai novērstu nereālu dizainu, ja projektēšanas spēki ir ļo� mazi vai nenozīmīgi.  

Piemēram, nosakot skrūvju skaitu vienkāršai sijas un sijas spārnu plāksnei:   

•  No ProtaStructure importētā kri�skā konstrukcijas bīde ir 30 kN. Tam nepieciešams 1. skrūvju skaits. 

•  Sijas bīdes jaudas koeficients ir iesta�ts uz 0,3. Tas izrādās 100 kN, kam nepieciešams 2. skrūvju skaits. 

•  Galīgais izmantotais bīdes spēks ir 100kN, tāpēc �ek izvēlēts 2 skrūvju skaits.  

Šādiem savienojumiem vispār nav pārbaudes vai noformējuma:  Haunch Connec�on, Apex Haunch 

Connec�on, Direct Welding Connec�on, Base Plate Without Design, Eaves Beam Connec�on, Profile Fit 

Connec�on, Sag Rod Connec�on & Sag Rod Holes, Welded Pipe Connec�on, Beam to Wall Connec�on, 

Apex Truss Gusset Connec�on & Truss End Plate With Gusset Plate Connec�on.  

Pirms savienojuma noformēšanas mums jāpielāgo noklusējuma noformējuma parametrs:  

➢ Ejiet uz File → Se�ngs → Project Preferences  

➢ Nodrošiniet ka Design Standards for Connec�ons ir iesta�ts uz EC3 

➢ General Overdesign Factor for Connec�ons = 1  

Tas nozīmē, ka savienojumi paras� �ks veido� 100% no dalībnieka jaudas. Šis iesta�jums darbojas kopā ar  
savienojošo dalībnieku jaudas koeficien�em (mainīts, izmantojot dialoglodziņu Profils →  

ProtaSteel darba uzsākšanas rokasgrāmata 
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Detailing Defini�ons). Jaudas koeficients �ek automā�ski aprēķināts = Projektētais spēks dalīts ar  
dalībnieka fak�sko jaudu. Tādejādi Capacity Ra�o x Overdesign Factor = Final Factor   

➢ piemeram, zem Steel Detailing  nodrošiniet sekojošo  

•  Plates Vēlamais plāksnes materiāls = S355 

•  Bolts : Vēlamais skrūvju materiāls = Class 8.8 

•  General Weld : Vēlamais me�nāšanas materiāls = Class 42 

➢ Apply → OK  

14. Pamatplates savienojums                                          

Lai izveidotu pamatplāksnes savienojumu ar kolonnām, mēs varam izmantot pamatplāksnes makro.  

Lai izveidotu pamatplāksnes savienojumu, ProtaSteel ir divi pamatplāksnes makro.s  

•  Pamatplāksnes savienojums (bez rasējuma) 

•  Vienkāršs pamatplāksnes savienojums (ar dizainu) 

Pakalpojumā ProtaSteel ierobežojumi ir norādī� ar bumbiņu un kubiskiem priekšme�em zaļā krāsā.  

Ja savienojums ProtaStructure ir definēts kā momenta savienojums, tas �ek parādīts ar lodi + kubiskais objekts.    

Ja savienojums ir veidots kā piesprausts savienojums, tas �ek parādīts �kai ar lodveida objektu.

 

Izmantojot “Pamatplates (bez rasējuma) Macro”, �ek izveido� visi veidi.   

 

 

 

     

 

 

 

 

 

➢ Atlasiet “Base Plate Connec�on Macro”  

➢ Atlasiet  column.   

➢ Savienojums �ek izveidots zem kolonnas.  
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Piespraustos savienojumus var izveidot, izmantojot “Simple Base Plate Macro”.   

Šis makross var izstrādāt un izveidot aprēķinu pārskatu. Visus parametrus var mainīt makro rekvizītos. 

 

    

 

 

 

 

 

 

 

15. Fin Plate savienojums    

Mēs izveidosim Fin Plate savienojumu starp blakus esošo galveno un primāro sijas savienojumu.  

➢ Ar peles labo pogu noklikšķiniet uz Fin Connec�on marco    

Parādīsies Fin Plate Macro dialoglodziņš, kas ļauj pielāgot savienojumus.  

➢ Dodie�es uz cilni Design Tab un pārliecinie�es, vai:  

•  Design Standard = EC3 

Piezīme: Slīdēšanas koeficients ir tukšs, tāpēc tas sekos projekta iesta�jumu → skrūvju iesta�jumiem.  

➢ Izvēlie�es Get, lai padarītu to par šī savienojuma veida noklusējuma iesta�jumiem visiem projek�em.    

➢ Tuviniet GL 2 / B-C līdz iepriekšējam savienojumam, kur sa�ekas sekundārais un 2 “L” s�prinājums.   

 
 
Svarīga piezīme: Jaudas koeficients darbojas kopā ar General Overdesign factor for Connec�ons (in Project Preference). 
Tādējādi, Capacity Ra�o x Overdesign Factor = Final Factor . 

 

➢ Veiciet dubultklikšķi uz sekundārā stara  

➢ Iekš Profile Proper�es ejiet uz Detailing 
Defini�ons tab 

Šīs sijas jaudas koeficients pēc noklusējuma ir 0,3.  

To izmantos, lai aprēķinātu pieslēgumam 
 

Cilnē Analysis tab �ek parādītas dalībnieka 
ģeometriskās īpašības. 

➢ Apply → OK  

1 

➢ Atlasiet “Simple Base Plate Connec�on Macro”  

➢ Atlasiet  column.   

➢ Savienojums �ek izveidots zem kolonnas.  

 

 

izmantoto minimālo konstrukcijas bīdi.
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Tagad mēs ievietosim gala plāksnes (fin plate) savienojumu
primārā un sekundārā sijas savienojumā. 

➢ Atlasiet Fin Plate Connec�on   

➢ 1 – Izvēlie�es galveno siju  

➢ 2 – Izvēlie�es sekundaro siju  

➢ Ar peles labo pogu noklikšķiniet 3 reizes 

Tiks izveidots fin plate savienojums  
 

1 

2 

Tagad mēs ievietosim stūrī pieskrūvēto s�prinājuma  
 

➢ Atlasiet Corner Bolted Gusset Plate Connec�on  

➢ 1 – Izvēlie�es galveno siju  

➢ 2 – Izvēlie�es s�prinājumu  

➢ 3 – Izvēlie�es zilo fin plate   

Savienojums ir izveidots.
Atkārtojiet to pašu ar otru s�prinājumu. 
 

1 

2 

3 

Macro Sign 

Padoms:  
❖ Savienojums sastāv no plāksnēm, skrūvēm un me�nātām šuvēm.

Katram elementam ir savas individuālās īpašības, un to var izvēlē�es, izdzēst vai mainīt.
  

❖ Visu savienojumu a�ēlo makro zīme.  
Veicot dubultklikšķi uz tās, �ks parādīts dialoglodziņš Makro, kurā var mainīt visu savienojumu. 

❖ Pirms izpildīšanas ir ļo� ieteicams pārska�t savienojuma makro iesta�jumus.  

plāksni L s�prinājumam, kas kā robežu izmanto fin plate.

Veicot dubultklikšķi uz tā, �ks atklātas elementa īpašības.
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16. S�ngrāks End plate savienojums   

Mēs izveidosim Beam to Beam End Plate Connec�on starp galveno un sekundāro staru.  

➢ Tuviniet blakus esošo savienojumu GL 2 / B-C, kur sa�ekas sekundārais un galvenais stars.    

 

17. Haunch savienojums   

Mēs izveidosim savienojumu starp kolonnu un staru pie GL B / 2.
 

 

 

 

 

  

Tagad mēs ievietosim haunch savienojumu. 

➢ Izvēlie�es Haunch Connec�on   

➢ 1 – Izvēlie�es kolonnu  

➢ 2 – Izvēlie�es siju  

Savienojums ir izveidots. Zilā caurspīdīgā kaste ir nogrieztais
objekts. To var ieslēgt / izslēgt dialoglogā Visibility.  

➢ Atkārtojiet to pašu ar siju otru galu.
 

 

1 

2 

➢ Izvēlie�es S�ffened End Plate Connec�on   

➢ 1 – Izvēlie�es galveno staru  

➢ 2 – Izvēlie�es sekundāro staru  

Savienojums ir izveidots.
Tas varbūt ir piemereotāks a�ecībā uz slodzes 
pārnesi, montāžas un uzbūves vieglumu. 
 

➢ Ar peles labo pogu noklikšķiniet uz

Haunch Connec�on

 

 

➢ Iekš Haunch Macro dodie�es uz Figure 2  

➢ Pārliecinie�es, vai ir pārbaudītas visas   
 

➢ Apply → OK lai izietu 

 

gala plāksnes A, B, C un D
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18. S�ngrāks gala plāksnes savienojums  

Kolonnu siju savienojumā pie režģa C / 3 izveidosim s�ngrāku gala plāksnes savienojumu. 

 

 

19. Corner Bolted Gusset Plate savienojums   

Tajā pašā savienojumā mēs savienosim diagonālo s�prinājumu. Ir problēma, jo esošais savienojums traucē, t.i.,  

mēs nevaram savienot diagonālo s�prinājumu �eši ar kolonnu augšējās s�ngrības plāksnes dēļ.

To var atrisināt, izmantojot Corner Bolted Gusset Plate Connec�on. 

 

  

➢ Dubultklikšķis uz 3. ass skata, lai atvērtu to-    

➢ Tuviniet savienojumu vietā, kur kolonna, sija 
  

➢ Nospiediet F9 uz šī savienojuma   

➢ Rotējiet skatu ap šo savienojumu  

➢ Izvēlie�es ikonu
S�ffened end plate connec�on

  

➢
 

1
 
–

 
Izvēlie�es kolonnu

 

➢ 2 – Izvēlie�es siju  

➢ Labais klikšķis → savienojums izveidots     

 

 

1 

2 

➢

  

Rotējiet skatu, lai savienojums netraucētu latas 

➢ Izvēlie�es Corner Bolted Gusset Plate Connec�on  

➢ 1 – Izvēlie�es kolonnu  

➢ 2 – Izvēlie�es augšējo s�prinājumu 

➢ 3 – Izvēlie�es augšējo oranžo plāksni 

Tiks izveidots loģisks un uzbūvējams savienojuma plāksnes

 
 

1 
2 

3 

un 2 diagonālās saites saskaras pie režģa C / 3

savienojums, kas savienos iepriekšējā savienojuma 
augšējo plāksni.
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20. Bolted Gusset Plate savienojums  

Apakšējā s�prinājuma gadījumā tā ir nedaudz atšķirīga situācija, jo s�prinājumam vajadzētu �eši pieslēg�es

sijas atloka apakšai. Tādēļ mums vajadzētu izmantot  Bolted Gusset Plate Connec�on. 

 

Pabīdīsim atpakaļ un saīsināsim zaļo starpsienu plāksni tā, lai tā būtu �eši sijas galā, lai to varētu uzbūvēt. 

  

➢ Atlasiet savienojuma macro, atlasot macro zīmi   →  Enter  

➢ Varat arī izvēlē�es savienojuma plāksni> nospiediet “M”> nospiediet taus�ņu Enter (gaidiet macro lodziņu)  

 

➢ Ievadiet 25 mm augšējā plāksnes atdošanas vēr�bā    →  Apply 

Var redzēt, ka plāksne ir saīsināta un pievienota s�ngrinātāja plāksne. 

➢
 

Rotējiet skatu ap savienojumu, lai jūs ska�tu 
 

 

➢ Izvēlie�es Bolted Gusset Plate Connec�on  

➢ 1 – Izvēlie�es siju  

➢ 2 – Izvēlie�es apakšējo s�prinājumu  

➢ Ar peles labo pogu noklikšķiniet 

Tiks izveidots loģisks un uzbūvējams starpsienu plāksnes
 

➢ Nospiediet ESC, lai atceltu makro.  

1 

2 

saites apakšdaļu.

savienojums, kas savieno sijas apakšējo atloku.
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21. Splice Savienojums  

Savienojuma savienojums vispirms jāievieto kolonnā vai sijā ProtaStructure.

    

 

•  Zaļās krāsas skrūves sauc par darbnīcas skrūvi.    

Šīs bultskrūves pirms to nogādāšanas ir iepriekš uzstādītas darbnīcā.  

•  Oranžas krāsas skrūves apzīmē skrūves, kuras jāsamontē uz vietas.  

Iepriekš minēto iesta�jumu un citus skrūvju parametrus var apska�t un mainīt Bolt Group Property:      

➢ Veiciet dubultklikšķi uz jebkura skrūves → parādīsies Bolt Group Property.     

➢ Dodie�es uz cilni  →  → nolaižamajā izvēlnē ir divas iespējas:Se�ngs 2 Assembly Loca�on       

•  Workshop 

•  Site 
 

  

•  Tas ir vairāk uzbūvējams, jo starpsienu 

 

•  Iepriekšējās nos�prinātās gala plāksnes būs
daļa no kolonnas komplekta.  

•  Tādējādi, kad kolonna un sija �ek nogādāta
vietnē, tos ir viegli un ātri uzstādīt 
un “savienot”.  

 

➢
 

Tuviniet stūra kolonnu pie GL D / 3, nedaudz virs 1. stāva
 

 

Ievērojiet, ka kolonna ir sadalīta 2 atsevišķos elementos, jo 
ProtaStructure �ka izveidota kolonnas savienošana. 

➢ Izvēlie�es Splice Connec�on   

➢ 1 – Izvēlie�es augšējo kolonnu 

➢ 2 – Izvēlie�es apakšējo kolonnu 

Pievienots kolonnas Splice savienojuma. 

➢ Nospiediet ESC, lai atceltu macro.   

1 

2 

plāksni un s�ngrumu var montēt ārpus 
vietas kā daļu no siju montāžas.

Šim modelim pie stūra kolonnas pie GL D / 3 800 mm augstumā virs 1. stāva ir ievietots savienojuma savienojums.
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22. Kopņu gala plāksne ar savienojuma plāksni 

Kopņu gala plāksne ar Gusset Plate savienojuma macro izveido savienojumu starp kolonnu un 

un sekundārajām kopnēm ar vītņu un galu plāksnēm. Koncentrēsimies uz kopni, izveidojot jaunu skatu gar A asi.    

➢ Ejiet uz Views → Create Views → By Two Points  

➢ Noklikšķiniet uz diviem punk�em gar A asi → skats �ks izveidots, kā parādīts zemāk.     

 
 

➢ Veiciet dubultklikšķi jebkurā jaunā skata vietā → Parādīsies View Proper�es.    

 

  
 

➢ Piešķiriet skatam jaunu nosaukumu “A ass” 

➢ Mainiet Up-Down method sadaļā View Proper�es uz Full→ Apply     

➢ Tuvināt kopnes kreiso pusi (A / 1 ass)  

➢ Nospiediet F9 un noklikšķiniet uz kolonnas mezgla augšdaļas, lai to iesta�tu kā interesējošo punktu.  

 

 

1 

2 
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23. Me�nātais cauruļu savienojums (�kai informācija)  

Cauruļu profilu savienošanai var izmantot me�nātu cauruļu savienojuma macro.  

 

24. Sijas savienojums ar (RC) sienas / kolonnas savienojumu (�kai informācija)  

Šis savienojuma maco izveido iebūvētu tērauda savienojumu starp tērauda siju un betona sienu vai kolonnu.

Tērauda elementam jābūt perpendikulāram dzelzsbetona virsmai. 

Ir svarīgi, lai uz betona virsmas būtu pie�ekami daudz vietas, pretējā gadījumā makro nedarbosies.    

 

➢ Izvēlie�es Truss End Plate with Gusset Plate     

➢ 1 – Izvēlie�es galveno kolonnu 

➢ 2 – Izvēlie�es augšējo akordu 

➢ 3 – Izvēlie�es diagonāli 

➢ Ar peles labo pogu noklikšķiniet, lai pārtrauktu  

➢ 4 – Izvēlie�es galveno kolonnu 

➢ 5 – Izvēlie�es apakšējo akordu 

➢ un izveidotu savienojumu  

Abi savienojumi �ek izveido�, kā parādīts.  

1 
2 

3 

4 
5 

➢ Klikšķiniet uz Welded Pipe Profile macro    

➢ 1 – Atlasiet galveno top dalībnieku  

➢ 2 + 3 – Atlasiet sekundāro profilu, piem.

diagonālais un ver�kālais elements. 

➢   

Profili �ek automā�ski sagriez� un apgriez�
 

 

2 

1 

3 

2 
1 

➢ Klikšķiniet uz Beam to Wall Connec�on macro    

➢ 1 – Atlasiet betona sienu vai kolonnu    

➢ 2 Izvēlie�es tērauda siju 

➢   

 

un izveidotu savienojumu

Ar peles labo pogu noklikšķiniet, lai pārtrauktu

un izveidotu savienojumu
Ar peles labo pogu noklikšķiniet, lai pārtrauktu

ap savienojumu.

un izveidotu savienojumu
Ar peles labo pogu noklikšķiniet, lai pārtrauktu

ProtaSteel darba uzsākšanas rokasgrāmata 



  
  

 26 

25. Intelliconnect pilnībā automa�zētai tērauda savienojumu projektēšanai   

IntelliConnect automā�ski novērtē savienojumus, sērijveidā izveido un noformē tērauda savienojumus.

Tas aptver plašu vienkāršu, momentu, savienojumu un me�nāšanas savienojumu klāstu.

Tas apsver konstruējamību, saprā�gi sakārtojot un konfigurējot savienojumu komponentus bez lietotāja iejaukšanās.  

Tā rezultātā ievērojami uzlabojas darba efek�vitate, jo samazinās laiks, kas vajadzīgs šos savienojumu izveidei.   

   

 

Kāpēc izmantot IntelliConnect? 

Uzlabota tērauda detalizācijas programmatūra paras� automā�ski izveido savienojumus starp diviem elemen�em,    

piemērojot noteiktus noteikumus, t.i., “uz noteikumiem bals�tus savienojumus”.  

Šie noteikumi paras� ietver tādus elementus kā profilu nosaukumi, momenta atbrīvošanās esamība vai tā trūkums, 

slodzes elemen� un pieejas apstākļi u�.  

                          

                        1. a�ēls            2. a�ēls 

Lai gan šī “uz noteikumiem bals�to savienojumu” iezīme ir noderīga vienkāršos gadījumos, kad galvenais 

un sekundārais (ienākošais profils) ir vienīgie divi profili, kas atrodas locītavā (skat. 1. a�ēlu), sarežģītu    

savienojumu gadījumā tas neizdodas, ja vairāk nekā divi elemen� sa�ekas vienā savienojumā (sk. 2. a�ēlu):  

❖ Sarežģītām locītavām akla “Rule based joint” piemērošana radītu milzīgu sadursmju skaitu, kā rezultātā 
manuālie grozījumi �ek izšķies� un neproduk�vi.  
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❖ “Uz noteikumiem bals��em savienojumiem” nebūs saprāta, lai  

   
 

❖ Tipisks piemērs (sk. 3. a�ēlu) būtu nepieciešamība pārvietot    

 
 

 

❖ “Noteikumu savienojumi” paras� neapvieno ienākošos elementus, 

 
 

❖ Piemēram (skat. 4. a�ēlu) divas horizontālās saites savienosies 
   

  
 

  

IntelliConnect ir progresīva tehnoloģija, kas mēģina risināt šos jautājumus, kas ir izpla�� ēkas detaļās. 
 IntelliConnect automā�ski nosaka, kurš savienojuma veids ir piemērotāks atlasītajiem profiliem,     

pārbaudot to veidu, atrašanās vietu un orientāciju. Ja nepieciešams, tas automā�ski maina savienojuma   
parametrus un izveido iespējamu un prak�sku savienojumu.  

IntelliConnect  

IntelliConnect var automā�ski izveidot savienojumus dažāda veida elemen�em un profiliem.   
IntelliConnect var nodrošināt risinājumu 36 dažādiem
gadījumiem, kas sagrupē� 9 kategorijās.
Šīs kategorijas var uzskai�t šādi: 

•  Splice savienojumi 

•  Ba�en plate savienojumi  

•  Sag rod savienojumi 

•  Ver�cal bracing savienojumi 

Figure 4

 

Figure 3

sekundāro locekli “automā�ski nobīdītu”, lai atvieglotu savienojumu.
Šādas prasības tērauda detaļās ir ikdiena, kad ienākošos locekļus 

nepieciešams nedaudz nobīdīt, lai izvairītos no sadursmēm un būtu
iespējama montāža.

horizontālo s�prinājumu grīdas sistēmās prom no siju 

krustošanās punk�em, lai izvairītos no sadursmēm ar savienojuma plāksni.

lai izveidotu vienu kopīgu savienojumu, ja situācija to prasa.

ar vienu un to pašu punktu atsevišķi, radot sadursmi starp rāmja
plāksnēm, nevis izmantojot vienu kopēju rāmja plāksni.
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•  Truss savienojumi  

•  Jumta latas savienojumi  

•  Grīdas siju savienojumi (ar horizontāliem
 

•  Sijas - kolonnu savienojumi (ar horizontāliem  
ver�kāliem s�prinājumiem, ja tādi ir) 

•  Pamatplāksnes savienojumi (ar ver�kāliem
s�prinājumiem, ja tādi ir) 

Tie ietver “vienkāršus gadījumus”, piem., kur ir �kai 2 primārie elemen� un “sarežģī� gadījumi”, kad vienā un 

tajā pašā mezglā sa�ekas vairāk elementu. 

Cases  

IntelliConnect aptver šādus vienkāršus gadījumus:   

1. Splice savienojums (atbalsta visus profilus, kurus atbalsta Splice macro)  

2. Kolonnas pamatplāksne bez ienākošām ver�kālām s�prinājumiem. (Kolonnai jābūt I sadaļai) 

3. Viena sija, kas ierāmēta galvenajā sija. Sijas var būt I vai ķēdes profili. 

Siju un staru savienojuma veids var būt jebkurš no šiem: 1) S�ffend gala plāksnes savienojums.

2) Fin plāksnes savienojums 3) Sijas un sijas gala plāksnes savienojums.  

4. Viena stara ierāmēšana kolonnā. Profili var būt I vai kanāla profili. 

Siju un staru savienojuma veids var būt jebkurš no šiem: 1) S�ffend gala plāksnes savienojums.

2) Fin plāksnes savienojums 3) Sijas un sijas gala plāksnes savienojums. 

5. Viena horizontāla saite, kas s�prinata sijā. Horizontālais s�prinājums var būt jebkurš profils, 

kuru atbalsta Bolted vītne vai me�nā� vītņu makro).  

6. Viena ver�kāla saite, kas s�prināta kolonnā. Ver�kālais s�prinājums var būt jebkurš profils, 

kuru atbalsta skrūvējamā vītne vai me�nā� vītņu makro. 

7. Atsevišķa o�ņa, kas sēž uz sijas vai kopņu elementa. Savienojuma veids var būt jebkurš savienojums,  

ko atbalsta latas macro.  

8. Viena kolonna, kas ierāmēta kolonnā. Savienojuma veids var būt jebkurš savienojums, 

ko atbalsta latas macro. 

9. Lokšņu plākšņu izveidošana uz dvīņu profiliem. 

10. Viena vijuma savienojums, kas nepārtrauk� iet virs kopnes vai jumta sijas.  

IntelliConnect aptver šādus sarežģītus gadījumus:   

1. Divas horizontālas saites, kas s�prinātas pie sijas (no jebkuras puses - auduma vai atloka).  

2. Divas ver�kālas latas, kas s�prinātas pie kolonnas (no jebkuras puses - auduma vai atloka).  

3. Kopņu savienojums ar vairāk nekā vienu kopņu sekundāro ierāmēšanu kopņu augšējā vai apakšējā akordā.

 4. Divas jumta latas, kas balstās uz pārseguma vai jumta sijas. 

5. Divi latojuma rāmji (kolināri vai pa vienam no katra ortogonālā virziena).  

6. Divas grīdas sijas, kas s�prinatas pie galvenās sijas no abām pusēm. 

7. Grīdas siju un horizontālo saišu kombinācijas, kas s�prinatas vienā otrā vienā punktā no abām pusēm.

 

s�prinājuma savienojumiem, ja tādi ir)
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8. Kolonnā ies�prinātas līdz 4 sijām (divas no atloka puses un divas no �kla puses).   

9. Siju un ver�kālo saišu kombinācija, kas ierāmēta kolonnā.  

Kas a�ecas uz profila �pu un savienojuma veidu ierobežojumiem, �ek piemēro� �e paši ierobežojumi, 

kas norādī� vienkāršos gadījumos. 

Kā izmantot 

Tālāk ir sniegts kopsavilkums par to, kā izmantot Intelliconnect:   

❖ Vispirms lietotājs izvēlēsies vienu vai vairākus mezglus, kas satur visu elementu informāciju,  
kas atrodas vienā punktā.  

❖ Pēc tam lietotājs vienkārši ar peles labo pogu noklikšķina un nonāk konteksta izvēlnē IntelliConnect un   
izvēlas izveidojamo savienojumu veidu.  

❖ Dažiem IntelliConnect savienojumiem tomēr lietotājam ir jāizvēlas rāmji, nevis mezgli (piemēram,   
vienkārši iepriekš minē�e 9. un 10. gadījumi.  

❖ Intelliconnect izmantos savu “iekšējo klasifikācijas algoritmu”, lai savienotu pēc iespējas vairāk no mezgliem.  
  ❖ Tomēr, ja rodas gadījums, kas ne�ek atbals�ts, tas vai nu daļēji savienos mezglu, vai arī atstās to nesais�tu.

 ❖ Tiks automā�ski parādīts detalizēts pārskats, kurā uzskai�� mezgli, kuri ir vai nav veiksmīgi savieno�.    
 ❖

 
Intelliconnect Node Control rīks ir interak�vs navigators, lai pārlūkotu un pārbaudītu punktus,      
kas daļēji savieno� vai nav savieno�.   

Jumta latojuma piemērs 

➢ Atlasiet tērauda konstrukcijas mezglus (savienojumus), kur vēla�es izveidot savienojumu. 

Savienojumi elementa galā ir parādī� kā zili punk�. Vienkāršības labad varat noklikšķināt un vilkt lodziņu, 

lai atlasītu visus dalībniekus, kuri pēc tam atlasīs arī mezglus.  

Ilustrācijas nolūkā mēs izveidosim slīpsavienojumus, pamatojo�es uz Quick Start Guide Steel modeli.

 

➢ Ejiet uz 3D View  

➢ Atlasiet visus kopņu locekļus un spolītes, ar peles kreiso taus�ņu noklikšķiniet uz velciet lodziņu ap �em. 

 

➢ Ar peles labo pogu noklikšķiniet → IntelliConnect → Izvēlie�es Create Purlin Connec�on.    
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➢ Purlin Wizard izvēlie�es vēlamo savienojuma veidu  

➢ Piemēram, izvēlie�es Angle Type” & “Reversed Cleat ”  

➢ Nākamajā vedņa dialoglodziņā ievadiet citus parametrus →  Run 

•  Var norādīt maksimālo leņķa kājas garumu vai profilu 

➢ Tiks atvērts AutoConnectLog teksta fails → Pārska�et tā saturu, jo tajā ir uzskai�� visi veiksmīgi / 
neveiksmīgi izveido�e savienojumi/  

  

 

Sija - kolonna - saites piemērs   

Ilustrācijas nolūkos mēs automā�ski izveidosim sijas, kolonnas un s�prinājuma savienojumu,   

pamatojo�es uz Quick Start Guide Steel modeli. 

➢ Pārejiet uz 1. stāva skatu → Atlasiet visus kolonnu un siju savienojumus gar 2. asi.    
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➢ Labais klikšķis → IntelliConnect → Izvēlē�es Create Column/Beam Connec�on 

Ja ir vairākas iespējamas savienojuma konfigurācijas, nākamajā dialoglodziņā varat izvēlē�es, kurš savienojuma  

veids jāņem vērā, un tas ir prioritārs.  

 

➢ Izvēlie�es apsveramos savienojuma veidus → Pielāgojiet prioritā�, izmantojot bul�ņu uz augšu / uz leju  
→

 
Next 

 

A�ecīgā s�prinājuma maiņa, pēc tam �ks parādī� saišu savienojumi un savienojuma iesta�jumi.
 

➢ Veiciet vēlamo regulēšanu → Run → Tad �ks izveido� savienojumi    
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IntelliConnect un savienojuma pasū�šana  

Kaut arī kār�bas detalizēšana bieži ir atkarīga no pašas struktūras, paras� labāk ir sākt no lieliem savienojumiem
pie maziem savienojumiem. Savienojuma secība ir atkarīga no struktūras lieluma un formas. 
Piemēram, daudzstāvu ēkām ir lietderīgāk sākt savienojuma procesu no apakšas.  
Lielākajai daļai struktūru būs līdzīgas, simetriskas vai iden�skas asis. 
iNeatkarīgi no tā, vai izmantojat IntelliConnect vai nē, ir ieteicams vispirms pabeigt rāmja savienojumus.  

Tipiskā noliktavas struktūrā ar kopni ieteicamais savienojuma pasū�jums ir norādīts zemāk:       

❖ Splice savienojumi (kolonnu, siju un kopņu locekļi)  

❖ Truss savienojumi  

❖ Apex savienojumi  

❖ Kopņu augšējo un apakšējo saišu savienojumi ar kolonnām 

❖ Base plate savienojums  

❖ Manuāli (lietotāja definē�) savienojumi (lietotāja definētus savienojumus var saglabāt vēlākai lietošanai
 un atkārto� izmantot līdzīgiem savienojumiem). 

❖ Starp kolonnu vai kopņu sistēmu izvietoto saspiešanas elementu savienojumi.   

❖ Ver�kālie un jumta s�prinājumi.  

❖ Latojuma savienojumi   

❖ Sag Rod savienojumi  

❖ Ba�en Plate savienojumi  

 

Daudzstāvu ēku konstrukcijām ieteicamais IntelliConnect izmantošanas komplekts ir norādīts zemāk;  

❖ Splice savienojumi  

❖ Beam-to-column savienojumi  

❖ Beam-to-Beam savienojumi 
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❖ Horizontālo s�prinājumu savienojumi  

❖ Base Plate savienojumi  

❖  Ver�kālo s�prinājumu savienojumi 

❖ Latojuma, sag rods un līstes/latas savienojumi   

Strādājot ar IntelliConnect, pasū�jumu var būt nepieciešams mainīt divu iemeslu dēļ:  

❖ IntelliConnect darbojas ar savienojumu. Vienlaicīgi �ek ņem� vērā visi savienojumi šajā savienojumā.    
Piemēram, kolonnu siju savienojuma gadījumā (sijas, kas savienojas ar abām kolonnas pusēm) ar 
ver�kālu s�prinājumu, Intelliconnect mēģinās izveidot visus savienojumus vienlaikus, lai novērstu 
sadursmi, izmantojot kopīgas detaļas. Tas mainīs detalizācijas kār�bu.

  
❖ Tā kā IntelliConnect darbojas ar savienojumu, nav skaidrs, vai pārējie savienojumi ir pārāk tuvu vai pārāk tālu    

viens no otra. Ja locekļi vai savienojumi ir pie�ekami tuvu, lai sadurtos, IntelliConnect var saskar�es  
ar konfliktu problēmām. Šajā gadījumā sadursmju noteikšanai var izmantot komandu Clash Check.  
IntelliConnect var palaist ar lietotāja pieprasīto pasū�jumu, lai tas neizmantotu citu savienojumu informāciju. 

  

Kopumā savienojumu zīmēšana jāuzsāk no galvenajiem savienojumiem. 
IntelliConnect var ak�vizēt, pamatojo�es uz �klu un stāvu. Var sekot latojums un sag rod savienojumi.    
Ba�en plate savienojumi būtu jāizveido kā pēdējie.  
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26. Savienojuma noformējuma ziņojumi 

ProtaSteel var izveidot konstrukcijas pārbaudes ziņojumus šādiem savienojumiem saskaņā ar EuroCode3, 
AISC (LRFD), AISC (ASD), BS5950  

•  Sijas savienojums ar siju:  End Plate, S�ffened End Plate, Fin Plate  

•  Sijas un kolonnas savienojums:  End Plate, S�ffened End Plate, Fin Plate  

•  Sijas un gala plāksnes savienojums  

•  Haunch savienojums 

•  Tiešais me�nāšanas savienojums 

•  Vienkāršs pamatplāksnes savienojums 

•  Atloku plāksnes momenta savienojums 

•  Paplašināts gala plāksnes savienojums 

•  Pieskrūvētu starpsienu savienojums 

•  Stūra skrūvētu starpsienu savienojums  

•  Me�nātā starpsienu savienojums  

•  Stūra me�nāto savienotājelementu savienojums 
 
ProtaSteel nevar izveidot nekādu aprēķinu pārbaudi šiem savienojuma veidiem:  

•  Base Plate savienojums 

•  Eaves Beam savienojums 

•  Fi�ng savienojums 

•  Sag Rod savienojums 

•  Latu un latojumu savienojums 

•  Splice savienojums  

•  Welded Pipe savienojums 

•  Apex Haunch savienojums 

•  Apex Truss Gusset savienojums 

•  Kopņu gala plāksne ar savienojuma plāksni 

•  Ba�en Plate savienojums 

•  S�ngrāka �mekļa atvēršana 

•  Vairākkārt pas�prināta �mekļa atvēršana 

•  Sijas ar sienu savienojums 

•  Embedded Plate savienojums 

•  Manuāls savienojums 
 
Pārska� ietver gan ģeometriskās pārbaudes, gan jaudas pārbaudes. 

Turklāt ērtai pārbaudei �ek parādī� starpposma aprēķini, atsauces uz a�ecīgajiem projekta koda punk�ems.

 
un atbilstošais vienādojums.
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Pārskatus var izveidot pēc pieprasījuma bagā�nāta teksta formātā (RTF).  
Noformējuma statusa krāsas pirms pārskata izveides var redzēt modeļa skatā. Lai vizuāli parādītu savienojuma   

➢ Ejiet uz View → Connec�on Design Ra�o Coloring 

Savienojuma krāsa būs kodēta:  = nav pārbaudīts;  = Pass;  = Fail.Dzeltens Zaļš Sarkans   
 

 

➢ Ar peles labo pogu noklikšķiniet → Connec�on Design Reports (vai Drawings & Report)     
Connec�on Reports → Atlasiet vajadzīgo pārskatu:   

•  Show Connec�on Report → Rādīt atlasītā (-o) macro savienojuma pārskatu 

•  Default Connec�on Report → Veidot savienojuma pārskatu atbilstoši projekta priekšraks�em 

•  EC3 / BS5950 / AISC_LFRD /AISC_ASD Connec�on Report → Izveidot savienojuma pārskatu atlasītajam kodam
 

27. Savienojuma kopsavilkuma tabula  

Savienojuma noformējuma tabulā ir sniegta informācija par atlasītajiem savienojuma makro. 

Kopsavilkuma tabulā parādīts “Frame Id”, makro atkarīgo profilu veidi, savienojuma veids, savienojuma capacity  

ra�o, noformējuma statuss atbilstoši jaudas koeficientam un tas, vai ir izveidots savienojuma pārskats. 

 

Lai pārbaudītu savienojumu un ģenerētu pārskatu: 

➢ Atlasiet savienojumu ar šīm metodēm:  

•  Atlasiet savienojumu ar macro sign   

•  Atlasiet jebkuru savienojuma komponentu 
(piemēram, plate vai bot) → nospiediet “M”   

•  Noklikšķiniet ar kreiso taus�ņu un velciet logu,
kas aptver visu savienojumu 

PADOMS: turiet nospiestu CTRL, lai atlasītu.   

 

 

izmantošanas koeficientu:
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➢ Atlasiet vienu vai vairākus savienojuma macro  

Ja nav atlasīts neviens macro, tabulā �ks parādī� visi modeļa atbals��e makro.  

➢ Ejiet uz Drawings & Reports → Connec�on Reports → Connec�on Design Summary 

Table 

 

Augšējās ikonas no kreisās uz labo: 

❖ Update →  Atjaunot tabulu  

❖ Show in Model →  Modeļa skatā atrodiet un tuviniet atlasīto makro.
Dubultklikšķis uz jebkuras rindas veiks to pašu funkciju. 

❖ Create Report → Izveidojiet atlasītā makro savienojuma noformējuma pārskatu.
Turiet nospiestu CTRL taus�ņu, lai atlasītu vairākas reizes. 

❖ Open Report → Atveriet izvēlēto noformējuma ziņojumu. 

Ja savienojums neizdodas, mainiet macro rekvizītus. Kad savienojuma parametri ir pie�ekami, savienojumu   

pārbaudiet vēlreiz, un krāsa būs zaļa.   

28.   Sadursmju pārbaude  

Pirms detalizētu vispārīgu izvietojuma rasējumu izveidošanas ieteicams veikt visu elementu sadursmes pārbaudi.  

Sadursmes pārbaudē �ek parādī� elemen�, kas saduras vai pārklājas:  

➢ Atlasiet visus vai dažus modeļa elementus 

➢ Ejiet uz Tools →  Diagnos�c Tools  →  Clash Check 

➢ Alterna�vi, ar peles labo pogu noklikšķiniet uz modeļa ekrāna un izvēlie�es Clash Check  
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Rezultātā �ks izvēlē� sadursmes elemen� (sarkanā krāsā). Sadursme no�ek, kad divi vai vairāki elemen� pārklājas.   

Paras� tas no�ek, ja savienojumi vēl nav izveido�.  

Piemēram, pirms savienojuma izveidošanas sijas end flange & web plate pārklājas kolonnā (kā parādīts zemāk). 

 .

 

Ja sadursmju pārbaude �ek veikta, atlasot abus elementus, pēc pārbaudes �e paliks atlasī�.  

29. Revīzijas modelis 

Pirms detaļu rasējumu izveidošanas ir svarīgi noteikt kļūdas un neatbils�bas, kas var pastāvēt modelī. 

Šī funkcija veiks vairākus modeļa testus, piemēram, punktu dublikātus.   

➢ Ejiet uz Tools → Diagnos�c Tools  → Audit Model 

➢ Atlasiet vēlamās pārbaudes →  Run Test 

 

Rezultātu pārskatā varat atlasīt objektu (-us) un modelī automā�ski pāriet uz to.   

30. Detalizēts vienumu pārvaldnieks     

Detalizēto vienumu pārvaldnieks izveido un pārvalda detaļu vienumus, piemēram, savienojumus.

Mēs varam izmantot šo funkciju, lai izveidotu eksplodētus savienojuma rasējumus ar dažādiem ska�em un 

 detalizētu informāciju, piemēram, izmēriem, skrūvju, me�nājumu u�.
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Šajā lodziņā �ek kontrolē� dažādi virziena ska�, kurus mēs vēlamies parādīt rasējumos.
Skats �ek parādīts 3 krāsās, sarkanā, zilā un zaļā krāsā. Katrai krāsai ir priekšējais un aizmugurējais skats. 

Iekš Detail Item Manager :  

➢ Apakšā ieraks�et “Con1”  

➢ Izvēlie�es Add → Con 1 �ks pievienots     

➢ Izvēlie�es Select Objects 

➢ Atlasiet siju, kolonnu un 2 s�prinājumus   
 ➢

 

Labais taus�ņš

 

Tajā brīdī, 3D skatā ap savienojumu parādās
“3D detaļu lodziņš” (kā parādīts tālāk).

 
 
 

➢ Tuviniet savienojumu, kurā esam izveidojuši
Grid C 

➢ Noklikšķiniet un velciet logu, lai atlasītu visus  
savienojumu komponentus, ieskaitot visas  

 

➢ Izvēlē�es Detail Item Manager  

Parādīsies dialoglodziņš Detail Item Manager. 

 

plāksnes, skrūves un me�nātās šuves.
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Katrai krāsai ir priekšējais un aizmugurējais skats. Tādējādi ir kopumā 6 iespējamie ska�jumi. 
Skatu nosaukumus var mainīt - tādēļ, ja savienojuma augšdaļa nav fak�skā augšdaļa, nomainiet vārdu manully.  

➢ Lai izveidotu šo savienojumu, atlasiet �kai Front & Right   

➢ Izvēlie�es Filter Box, lai parādītu �kai savienojuma elementus (Restore Filter, visi elemen� �ks atjauno�)    

➢ Noklikšķiniet uz ikonas “+”, lai pievienotu savienojuma 3D skatu (ja vēla�es) 

➢ Aizveriet, lai saglabātu un aizvērtu dialoglodziņu  

➢ Atkārtojiet tās pašas Splice Connec�on savienojumam stūra kolonnā pie GL D / 3   

Prakses nolūkos mēs varam līdzīgi ievietot savienojuma lodziņu savienojumiem, kurus iepriekš esam izveidojuši
Storey 1. Darbību kopsavilkums ir šāds:  

➢ Atveriet skatu, kas ir vispiemērotākais savienojuma ievietošanai, izmēģiniet 1. stāva skatu.,  

➢ Tuviniet savienojumu  

➢ Noklikšķiniet un velciet logu, lai atlasītu visus savienojumu komponentus, ieskaitot visas plāksnes un skrūves.
 

➢ Izvēlie�es Detail Item Manager  

➢ Piešķiriet savienojumam nosaukumu 

➢ Noklikšķiniet uz Select Objects un pick all the members   

➢ Atzīmējiet vajadzīgā skata virziena lodziņu  

➢ Aizveriet dialoglodziņu  

Mēs esam pabeiguši savienojumus un tagad esam gatavi ģenerēt rasējumus.  
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31.  Rasējumu sagatavošana  

ProtaSteel ir spēcīgs rīks rasējumu sagatavošanai - to vienkārši sauc par “Drawing module”. 

Rasējumi ir bals�� uz modelēšanas modulī sagatavotajiem ska�em. Darbības ir apkopotas šādi:

  ➢ Galvenajā modelēšanas skatā izveidojiet vēlamos skatus.  

➢ Pārliecinie�es, vai skata orientācija, kuru vēla�es izmantot rasējumā, ir pareiza, jo rasēšanas
modulis automā�ski izmantos jaunākos skatus. 

•  Veiciet dubultklikšķi uz Axis 3 skata → Nospiediet F4, lai a�esta�tu skatu uz noklusējumu   

•  Veiciet dubultklikšķi uz Storey 1 skata → Nospiediet F4, lai a�esta�tu skatu uz noklusējumu     

➢ Izmantojot Detail Item Manager, izveidojiet visus detaļu skatus, piemēram, informāciju par savienojumu.   

➢ Sāciet Drawing module, veicot dubultklikšķi uz Drawings, kas atrodas Explorer pane (Ctrl + D).   

32. Rasēšanas modulis 

Rasēšanas modulī �e paši ska�, kas �ka parādī� galvenajā modelī, �ks dublē� sadaļā Explorer → Modelling Views: 

  •  3D View – Modeļa 3D skats  

•  Storey F – pamatu plāna skats (ST00 ProtaStructure)  

•  Storey 1 – Storey 1 plāna skats, kā noteikts ProtaStructure 

•  Storey 2 – Storey 2 plāna skats, kā noteikts ProtaStructure 

•  Axis 3 – Jauns skats pa 3. asi  

•  Axis A – Jauns skats gar A asi  

Ja jums nav vienādu skatu, lūdzu, aizveriet zīmēšanas moduli, lai atgrieztos pie galvenā modeļa,  

un izveidojiet skatu, kā norādīts iepriekšējās sadaļās. 

33. Rasējumu izveide, izmantojot Drawing Manager  

➢ Veiciet dubultklikšķi uz Drawing Manager (vai F6)   

Zīmējumu pārvaldnieks ir tas, kur jūs varat sākt jaunu zīmēšanu. 

Pamatnes Storey 1 un Storey 2 plāna rasējumu paraugi jau ir izveido� un uzskai��.  

 

View Manager ļauj pārvaldīt rasējumus:  

➢ Atlasiet Storey 1 → Open Drawing     

➢ Alterna�vi, vienkārši veiciet dubultklikšķi uz Storey 1, lai to atvērtu  

➢ Aizveriet Drawing Manager un pārska�et zīmējumu   
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Ārējā brūnā līnija ir rasējuma robeža (A0 izmērs). Rasējuma izmēru un citus iesta�jumus var mainīt:
 

 

➢ Veiciet dubultklikšķi uz jebkuras tukšas vietas rasēšanas robežā, lai piekļūtu Drawing Proper�es.   

  

Iekšējā punktētā zilā līnija ir skata loga apmale, kas ir �eši sais�ta ar skatu:   

➢ Novietojiet peles kursoru apakšējā labajā stūrī → kursors mainīsies, lai mainītu izmēru   

➢ Noklikšķiniet un velciet, lai mainītu izmērus un nodrošinātu, ka visi elemen� ir redzami.  

➢ Novietojiet peles kursoru pie robežas līnijas → noklikšķiniet un velciet, lai pārvietotu reģiona pozīciju.  

➢ Veiciet dubultklikšķi uz jebkuras vietas Viewport, lai piekļūtu Viewport Proper�es    

Piezīme: pašreizējā laidienā reģions ir pārdēvēts par Viewport.  

Parādīsies Documents Proper�es, kuros var mainīt: 

•  Drawing Name 

•  Print Area & Margin 

•  Paper Size & Orienta�on 

•  Created, Approve by, Approved Date 

•  Document State : Normal / Freeze / Broken 

 

Rasēšanas robeža 

Viewport robeža  
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Parādīsies dialoglodziņš Viewport Proper Editor.
Cilnē General tab var mainīt:  

•  Reģiona nosaukums 

•  Mērogs 

•  MovX, Mov Y : koordinātas  

•  Rotācija: norāda rotācijas leņķi  

•  Drawing Mode : Line/All Visible/Hidden Line/Full Dashed 

➢ Mainiet nosaukumu uz Storey 1 plānu 

➢ Mainiet skalu uz 25   

➢ Mainiet Draw Mode uz Hidden Line → Apply 

Rasejums �ks atjaunināts mērogā un slēptā līnijā.  

➢ Izvēlie�es Fit, lai ievietotu visus elementus un nosaukumu.  

 

 

 

 

➢ Ejiet uz Label Se�ngs  

Dialoglodziņā Label Se�ngs varat mainīt:  

•  Label Posi�on 

•  Offsets  

•  Name & Scale Text Se�ngs 

➢ Izvēlie�es Locate Outside, lai e�ķete atrastos 
ārpus reģiona robežas 

➢ Atzīmējiet Write Name & Scale Text Se�ngs 

➢ Atlasiet Change zem Name Text Se�ngs 

➢ Change Name Teksta augstums līdz 10mm → OK 

➢ Change Scale Teksta augstums līdz 10mm → OK → Apply 

Ievērojiet, ka rasējumā nosaukums un mērogs ir lielāks.  
 

 

 

 

 

  

 

➢ Ejiet uz Filtering  

Šeit esošās opcijas kontrolē rasējumā redzamo:  
•  Augšup (+) un lejup (-) filtrē objektus papīrā un ārpus tā 

•  Min X un Max X filtrē objektus X plāna virzienā  

•  Min Y & Max Y filtrē objektus Y plāna virzienā  

•  Up-Down metode:  
- Par�al: 
Jebkurš elements, kas daļēji pastāv iepriekš minētajos apjomos. 
- Full: 
Tikai elemen�, kas pilnībā pastāv iepriekšminētajos apjomos. 

•  Filtering Se�ngs  – pakļaut vairāk filtru opciju  

➢ Mainiet Up (+) uz +500 un Down (-) uz -500 → Apply →        
Latojums pazūd, jo tas ir novietots nedaudz
virs grīdas līmeņa. 

➢ Atlasiet Filter Se�ngs  
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

zem
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34. Profila anotācija  

Tagad mēs pievienojam tērauda profila anotāciju, t.i., parādām dalībnieku izmērus. 
Pirmkārt, mums vajadzētu izvēlē�es dalībniekus, kurus vēlamies pievienot anotācijām.  

➢ Klikšķiniet uz Selectability ikonu   (vai View → Selectability Se�ngs) 
Drawing Op�ons dialoglodziņā 

 
 

➢ Rasējumā noklikšķiniet ar peles kreiso taus�ņu un velciet lodziņu ap visiem tērauda elemen�em, lai tos atlasītu.  

➢ Ar peles labo pogu noklikšķiniet uz ikonas Profila anotācija, lai piekļūtu anotācijas iesta�jumiem.   
 

 

Šeit iesta�jumi kontrolē, kā tērauda elemen� �ek
anotē� (marķē�):  
•  Dažādu veidu anotācijas ir norādītas tabulā.  

•  Noklikšķiniet un velciet jebkuru anotācijas
nosaukumu lodziņā, kas nosaka anotācijas pozīciju 

➢ Klikšķiniet un velciet 
Profiles, Material & User Defined 3  

➢ Noklikšķiniet uz Annota�on Se�ngs, lai ska�tu  
vai mainītu teksta iesta�jumus:   
•  Fonta veids un lielums 

•  Anotāciju formāts vai s�ls  

➢ Mainiet Text Height  uz 7 mm  

➢ Noklikšķiniet Apply & Create Annota�ons  

  

 

c 

➢ Un�ck Viewport → OK   

Tas neļauj jums izvēlē�es reģiona robežu.  

Tās pašas opcijas ir pieejamas cilnē Visibility, kas kontrolē 
rasējumā redzamo.    

 
 

 
 

 

/ 

Filter Op�ons ļauj filtrēt:  

•  General : Steel, Concrete, Unique ID, etc  

•  Object types : Grid, Profile, Joint, Weld, etc 

•  Profile : Columns, Beams, Brace, etc 

•  Plate : Plate IDs, Types & Usage 

•  Solid & Macro  

➢ Ejiet uz Profile tab 

➢ Atzīmējiet Column, Beam, H. Brace 

➢ Izvēlē�es OK lai izietu 

Tas nodrošina, ka �ek parādī� �kai kolonnas,
sijas un horizontālie elemen�.  
 

 

 

 

 

 

Lai viegli atlasītu dalībniekus, mēs varam kontrolēt, kādi elemen� ir atlasāmi:
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Anotācijas �ek pievienotas visiem tērauda elemen�em, kā parādīts zemāk.  

 

35. Dimensija  

Dimensijas rīki   var izmantot izmēru ievietošanai rasējumā.   

 

Ievērojiet, ka dimensija �ek parādīta dinamiski. 

➢ Kreisais klikšķis uz 3. punkta un pēc tam uz 4. punkta.   

➢ Pārvietojiet peles kursoru �eši tajā vietā, kur vēla�es ievietot tekstu.      

➢ Ar peles labo pogu noklikšķiniet, lai aps�prinātu un izveidotu izmērus.  

Izmēri �ks izveido�, kā parādīts zemāk.  

 

Piezīmes 

❖ Varat arī noklikšķināt uz OK, lai izietu no rāmja. 

Anotācijas dialoglodziņš → Atlasīt elementus →  
ar peles kreiso taus�ņu noklikšķiniet uz ikonas   

❖ User Defined 3 ir ProtaStructure dalībnieku 
 apzīmējumi, piemēram, 1B1, 1C1 

❖ Anotācijas pozīciju var pārvietot, noklikšķinot
ar kreiso taus�ņu un velkot 

❖ Anotācijas var izdzēst, izmantojot taus�ņu Delete  

❖ Anotācijas teksta izmēru, fonta augstumu u�. 
Var mainīt, atlasot tos → ENTER →    

 

 

➢
 

Tuviniet augšdaļu ap primāro siju gar D asi 

➢ Klikšķis uz Horizontal Dimension  

➢ Ar peles kreiso taus�ņu noklikšķiniet uz 1.    
punkta un pēc tam uz 2. punkta starp punk�em 

➢ Pārvietojiet peles kursoru pa labi  

 

1 2 

3 4 

Profile Annota�on

Annota�on Text Property Editor
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36. Savienojuma detaļas izveide 

Tagad izveidosim jaunu savienojuma zīmējumu savienojumam, kuru izveidojām Grid 3.  

➢ Veiciet dubultklikšķi uz Drawings Manager (vai F6)  

➢ Izvēlie�es Create Drawing → Create Drawing Dialog parādīsies   

 

➢ Nosauciet Connec�on Axis 3 

➢ Mainiet Paper Size uz A1 → Orienta�on = Landscape        

➢ Izvēlie�es  Drawing Type =  Steel Connec�on Detail  

➢ Izvēlē�es OK → Zīmējums �ks izveidots vai automā�ski atvērts  

➢ Aizveriet dialoglodziņu Drawing Manager (ja �ek parādīts uzaicinājums saglabāt, izvēlie�es OK)    

Tiks atvērts un fokusets rasējums “Connec�on Axis 3”.
Rasējums ir tukšs, un mēs ievietosim vajadzīgo skatu rasējumā. 

➢ Right-click uz Axis 3 View → Create Viewport  

 

Skata reģions �ks ievietots, bet reģions, iespējams, nav pareizi novietots. Pārvietosim to zīmēšanas robežās.
Lai to izdarītu, mums jāspēj izvēlē�es zilo reģiona robežu.  

➢ Noklikšķiniet uz ikonas Selectability,        lai piekļūtu dialoglodziņam Drawing Op�ons      

 

➢ Atzīmējiet Viewport → OK   

➢ Noklikšķiniet un velciet skata punktu Drawing Sheet

 
 
 

 

 

 

 

 

c 
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➢ Ar peles labo pogu noklikšķiniet uz makro ikonas Connec�on Detail Drawing  

Šajā dialoglodziņā varat iesta�t savienojuma rasējuma detaļas, piemēram, mērogu un anotāciju.  

 

➢ Sadaļā Annota�on & Display Se�ngs pārska�et Annota�on, Field un Text & Display.    

➢ Klikšķiniet uz Connec�on Detail Drawing Macro ikonu 

Savienojuma detaļas �ks ievietotas rasējumā, kā parādīts zemāk.  

 

➢ Veiciet dubultklikšķi uz reģiona, lai piekļūtu  
Viewport Property Editor 

➢ Mērogs var būt mainīts, bet atstāsim 
to kā noklusējumu  

➢ Pārejiet uz cilni Filtering → mainiet uz    
Up = 500 un Down = 500   

➢ OK lai aizvērtu dialogu  

Ievērojiet, ka ap savienojumu ir aplis - tas ir 
�eši sais�ts ar savienojuma lodziņu, kas   
izveidots galvenajā modelī.  
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Var veikt turpmāku savienojuma detaļu pielāgošanu.  

 

 

 

Plate, Bolts & Weld Annota�on rīki      
 
Skrūves, plāksnes un me�nātās detaļas automā�ski �ek anotētas iepriekš minētajā piemērā.

Ja vēla�es, varat to izdarīt manuāli, izmantojot plākšņu, skrūvju un me�nāšanas anotācijas rīkus  

➢ Turiet nospiestu CTRL taus�ņu → atlasiet visas “Front” detaļas anotācijas → izdzēsiet tās   

➢ Noklikšķiniet un velciet logu (no labās uz kreiso), lai atlasītu anotējamās skrūves un plāksnes     
(nav svarīgi, ja ir atlasī� ci� objek�) 

  

➢ Veiciet dubultklikšķi uz savienojuma detalizētā reģiona,  
lai piekļūtu Viewport Property Editor  

Sadaļā Detailing varat mainīt:  

•  Bolt Import Style  

•   Bolt Drawing Style  

➢ Izmēģiniet dažādas iespējas un noklikšķiniet uz Apply 

 

 

 ➢ Ejiet uz Filtering tab → Atlasīt Filter 
Se�ngs  

➢ Ejiet uz Object Types  

Jūs varat izvēlē�es ieslēgt / izslēgt objektus. 

➢ Atzīmējiet Weld → OK → Apply  

Me�nājumi, kas parādī� biezākās līnijās,    

 

 

 

 

➢ Ar peles labo pogu noklikšķiniet uz Bolt   
Annota�on Se�ngs, lai piekļūtu iesta�jumiem 

➢ Izvēlie�es Clear, lai noņemtu esošos iesta�jumus  

➢ Noklikšķiniet un velciet Count, Diameter & Material    
uz apakšējo lauku 

➢ Izvēlie�es Annota�on Se�ngs, lai ska�tu /  
mainītu fonta veidu, krāsu u�. → OK  

➢ Izvēlē�es Apply & Create Annota�ons 

 

 

 

 

 

 

 

 

 

�ks paslēp�.
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Jums vajadzētu iegūt informāciju, kas ir līdzīga zemāk redzamajam a�ēlam (atkarībā no jūsu vēlmēm).   

 

37. Objektu numerācija  

Pirms daļu un montāžas skatu un rasējumu izveidošanas  

objek�em jābūt numurē�em. Pēc noklusējuma visi objek� ir iekļau�  

vienā numerācijas grupā. Lai objektus piešķirtu dažādām grupām:    

➢ Veiciet dubultklikšķi uz objekta, lai atvērtu dialoglodziņu Profils   

➢ Cilnē Detailing Defini�ons ievadiet Drawing Group numuru    

Šī funkcija �ka izstrādāta, lai numurētu dažādas struktūras daļas  

atsevišķi.  

Katrai objektu grupai var norādīt prefiksu un sākuma numuru.   

Pēc numerācijas procesa  fak�skā detaļa un montāžas numurs, 

�ks parādīts sadaļā “Actual Number”. 

➢ Ejiet uz Drawings & Reports → Numbering → Perform Numbering 

Parādīsies dialoglodziņš Numbering Op�ons. 

 

 

➢ Ar peles labo pogu noklikšķiniet uz Plate Annota�on  
lai piekļūtu iesta�jumiem 

➢ Izvēlie�es Clear, lai noņemtu esošos iesta�jumus  

➢ Noklikšķiniet un velciet PL Thickness, & Material 
uz apakšējo lauku 

➢ Izvēlie�es Annota�on Se�ngs, lai ska�tu /  
mainītu fonta veidu, krāsu u�. → OK  

➢ Izvēlie�es Apply & Create Annota�ons 

 

 

 Rasējumu var vēl uzlabot:  

➢
 

Dodie�es uz Viewport Proper�es Editor 
 

un mainiet mērogu
 

➢
 

Lai mainītu savienojumu, mainiet Offset (X,Y)
 

 

➢ Delete visas anotācijas, kuras, jūsuprāt, 

 nav vajadzīgas 

➢ Noklikšķiniet un velciet anotāciju, lai to mainītu  
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Tā kā modelis �ek nepārtrauk� pārska�ts, numerācijas process jāatkārto. ProtaSteel ir plašas 

pārnumurēšanas iespējas. Numerācijas opcijas var konfigurēt arī atbilstoši ražotāja vēlmēm.     

Piemēram, ir iespēja ģeometriski iden�skai daļai piespiest to pašu numuru.

 

Veikt numerāciju 

❖ Norāda, vai numurēt izvēlēto grupu.  

Unikālais numurs 

❖  Unique: Var izvēlē�es dzelzsbetona elemen�em. Objek�em �ek piešķirts atšķirīgs skaitlis neatkarīgi no to     
 ģeometriskajām īpašībām.  

❖  Not Unique: jāizmanto tērauda modelim. Izgatavo numerāciju, aplūkojot ģeometriju un materiāla īpašības. 
 

❖ Telpiskā kārtošana: Var izvēlē�es dzelzsbetona modelim. Veic numerāciju atbilstoši objekta atrašanās vietai.: 
Objekta atskaites punktu vispirms sakārto X un pēc tam Y. Dažādiem līmeņiem ir jāizveido dažādas grupas.

 

Pārnumurēt visu 

❖  Modified: numurējiet �kai modificētos objektus. Ignorē objektus, kas nav mainījušies.  

❖ Renumber: Visu objektu numurēšana. 

Reuse Old Numbers 

❖ Reuse: Izmanto vecos numurus. 

❖        : Nelietojiet vecos numurus. Pēc izmaiņām skaitlim var nebūt elementu. 
Norāda, vai izmantot šo numuru jaunam elementam.  

Modified Part 

Piemēram, mums ir 3 P5, 2 P7; tad 3 P5 P5 ir tādas pašas izmaiņas un ir kļuvušas tādas pašas kā P7.      

 
❖ Keep Number If Possible: Saglabā numurus, ja iespējams, pēc izmaiņām. c

Ja �ek izmantots iesta�jums, rezultāts joprojām ir 3 P5, 2 P7.   

❖ Compare to Old : Ja iespējams, salīdzina un piešķir daļu atzīmes no iepriekšējās numerācijas.
Ja �ek izmantota šī opcija, rezultāts ir P7 5 nos.   

❖ Take New Number: Piešķir jaunas daļzīmes. Šī opcija novedīs pie 2 P7 un 3 P8.    

  

- 
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Jauna daļa 

Līdzīgi kā “Modified Se�ngs”. A�ecas �kai uz jaunizveidotajiem objek�em. Tādējādi nav iespējas 

“Keep the Number If Possible”. 

❖ Compare to Old : Ja iespējams, salīdzina un piešķir daļu atzīmes no iepriekšējās numerācijas.  

❖ Take New Number: Piešķir jaunas daļu atzīmes. 

38. Daļu un montāžas rasējumu izveide  

Ja pēc revīzijas modeļa, sadursmes pārbaudes un numerācijas nav problēmu, var izveidot detaļu un   

montāžas rasējumu. 

Daļu un montāžas zīmējumu var izveidot visam modelim vai �kai dažiem objek�em.  

➢ Atlasiet visu modeli vai objektus  

➢ Ejiet uz Drawings & Reports → Drawings → Create Assembly Drawing / Create Part Drawing   

Tiks palaists zīmēšanas modulis un izveido� zīmējumi.  

➢ Sadaļā Drawing Manager  → Veiciet dubultklikšķi, lai atvērtu un pārska�tu zīmējumu   
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39. DXF Export  

Visus ProtaSteel izveidotos rasējumus var eksportēt kā DXF formātu:  

➢ Veiciet dubultklikšķi uz Drawing Manager (vai F6)   

➢ Zem DXF Export  →  Izvēlē�es Se�ngs  

DXF eksportēšanas iesta�jumos varat izvēlē�es eksportējamos slāņus, mainīt slāņa nosaukumu un līnijas veidu.
 

 

 
 

➢ Aizveriet DXF eksportēšanas iesta�jumus  

➢ Izvēlie�es Export → Izvēlie�es mērķa mapi → OK   

DXF rasējums �ks izveidots atlasītajā mapē.  

40. IFC failu eksports 

ProtaSteel modeli var eksportēt kā Industry Founda�on Classes (IFC) failu.  IFC ir BIM datu struktūra,
ko izveidojusi buildingSmart Interna�onal, un tā ir ISO 16739: 2013 standarts. IFC faila formātu ievieš lielākā daļa
projektēšanas programmatūras �rgū, tostarp vadošās ēkas informācijas modeļa (BIM) pla�ormas, piemēram,  
Autodesk Revit, Bentley un Tekla Structures.  
Tas ļauj apmainī�es ar ēkas informācijas modeļiem starp dažādām BIM pla�ormām.  

➢ Atlasiet eksportējamos objektus kā IFC faila formātu.  

Ja neviens objekts nav atlasīts, visi objek� �ks eksportē�. 

➢ File → Export →  IFC Export  
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➢ Noklikšķiniet uz ‘…’, lai norādītu eksportējamo faila nosaukumu un vietu.  

➢ Pārbaudiet vēlamās eksportēšanas opcijas → Export  
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41. Noslēguma kopsavilkums 

Apsveicam! Jūs esat izveidojis tērauda modeli un ģenerējis programmā ProtaSteel inženiertehniskos rasējumus.
  

 

Šajā rokasgrāmatā mēs esam importējuši no ProtaStructure modeli programmā ProtaSteel.

Pēc tam ievietojām papildu tērauda elementus, piemēram, s�eņus, pielāgojām elementus to galīgajām pozīcijām

un izveidojām inženiertehniskos rasējumus. Tas dos jums nepieciešamās zināšanas, lai izveidotu reālu projektu.

 

Lai iegūtu papildu palīdzību un norādījumus, lūdzu, ska�et ProtaSteel Help.  

Varat arī apmeklēt mūsu apmācības kursus, lai iegūtu padziļinātākas zināšanas par programmatūras lietošanu.

Lūdzu, apmeklējiet mūsu vietni , lai iegūtu vairāk informācijas.www.protaso�ware.com   
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